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1	 General

The EAZ Designer was specially developed for the EAZ-TFT, EAZ-TFT.110 and EAZ-TFT.45 displays for 
the purpose of developing customer-specific designs.

1.1	 Abbreviations, characters and symbols used 

Symbol / 
abbreviation

Meaning

EAZ position indicators


Delivery condition 
Settings that are supplied as standard are marked with an asterisk .

► Operational instructions
Perform the tasks that follow this symbol in the specified order.

Warning notice
This symbol is located in front of safety-relevant information

Information notice
This symbol is located in front of relevant information.

1.2	 Notation 

Notation Meaning

Bold 	› Designations of switches and actuators
	› Input values

Italics 	› Captions
	› Cross references
	› Designations of functions and signals
	› Product names

Bold italics 	› Remarks

LCD font 	› System messages of the controller
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1.3	 Further information

The following documents, among others, are available for the position indicators:

	› EAZ-TFT manual

	› EAZ-TFT.110 manual

These and other current manuals can be found in the download area of our website at  
https://www.newlift.de/downloads-311.html

1.4	 How to contact us

If, after referring to this manual, you still require assistance, our service line is there for you: 

Phone		  +49  89  –  898  66  –  110 
E-mail		  service@newlift.de

Mon. - Thurs.:  	   8:00 a.m.  –  12:00 p.m. and 1:00 p.m.  –  5:00 p.m. 
Fr:		  8:00  a.m. –  3:00 p.m. 
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2	 Requirements

2.1	 System requirements

2.1.1	 Hardware

	› PC equipment: internal or external SD card reader

	› Processor: Pentium 1 GHz

	› Main memory (free): 200 MB

	› Additional free memory: as required

	› Screen resolution: 1280 x 960

	› Memory medium according to table

TFT version Memory medium

EAZ-TFT Standard SD card, ScanDisk, 4 GB

EAZ-TFT.45 USB stick, at least 1 GB

EAZ-TFT.110 USB stick, at least 1 GB

2.1.2	 Software

	› Operating system:	 Microsoft Windows XP, Vista, Windows 7, Windows 8,  
				    Microsoft .NET Framework 3.5

2.2	 Installing/uninstalling

Installing the EAZ Designer

	►Open the NEW LIFT website https://www.newlift.de/downloads-311.html

	►Find the EAZDesigner <s_eazdesigner:vx_x.zip> in the list of PC-Software and download it.

	►After successfully downloading, extract the software to the desired directory.

	►Start the <Setup_EazDesigner.exe> file with a double-click.
	►Follow the instructions of the Setup Wizard and install the program.

You can now use the EAZDesigner.

Uninstalling the EAZ Designer

	►Use the Windows Explorer to navigate to the uninstall program under  

C:\Program Files (x86)\NewLift\EazDesigner\unins000.exe.

	►Start the <unins000.exe> application with a double-click.

EazDesigner is uninstalled.
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3	 Software reference

3.1	 Screen layout

1

4

3
2

5

1 Menu bar 4 Design

2 Tabs 5 Preview area 

3 Navigation bar

3.1.1	 Menu bar

Menu item Function

New Opens a new design

Open Opens the project folder of the EAZDesigner
Save Saves the current design

Save as... Opens the window to save the current design

Create display output Opens the window to select the the memory medium for a finished design

Format SD card Formats the SD card

Language: Drop-down menu Select language
Preview tab Opens the Preview tab

Display tab Opens the Display tab

Background tab Opens the Background tab

3.1.2	 Tabs

Tabs Function

Preview Displays already created and stored designs

Display Area for editing and creating designs

Background Area for background editing

3.1.3	 Navigation bar

The navigation bar is only displayed in the Preview tab.

Menu item Function

Project Path drop-
down menu

Opens the Windows browser for setting the preview and memory path

Size drop-down
menu

Opens a selection for setting the symbol size of the designs in the preview 
area

Preview refresh button Updates the preview display  
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4	 Operation 

4.1	 Preview tab

When opened, EAZDesigner automatically starts in the Preview tab.  
The first time it is opened, at least one demo design appears in the preview area. 

	►Start and edit this design as you wish.  
See “Opening an existing design” on page 9.

or

	►begin with the creation of a new design. 
See “Creating a new design” on page 9.

Changing the symbol size of the designs

	► In the navigation bar, select the   Size drop-down menu.

	►Click on the desired symbol size.  
The designs are displayed in the preview area with the new symbol size. 

*** Extra large symbols

** Large symbols

* Medium symbols

Changing the preview and memory path

By default, the program opens the following path:  
C:\ProgramData\Newlift\EazDesigner\Projects\standard\

In the preview area, all designs are that were stored in the path shown under the navigation bar are 
displayed. 

If you stored a design in a different directory using Save As..., you must use the Project Path function to 
navigate to the project folder.

	►Click on the Project Path button in the navigation bar.

	►Navigate to the desired project folder and confirm with OK.

	►The new project path is now displayed in the navigation bar. 
The designs are not yet visible.

	►Click on the Refresh Preview button to display the designs located in your directory.

The next time the program is started, it automatically opens the most recently set path. 
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Opening an existing design

	►Click the desired design. 
The selected design is displayed with a red background.

	►Click on the Open button in the lower right edge of the design preview. 
The program automatically switches to the Display tab.

Creating a new design

	►Click on the New button in the menu bar.  
 The New Project window opens.

	►Select the model of your position indicator.

	► If necessary, select the orientation of your position indicator and click on the OK button.  
The program automatically switches to the Display tab.
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4.2	 Display tab

In the Display tab, you can create new designs and customize them using position frames and dialog 
boxes.

 

1

4

3
2

5

6
7 8

9

12

1110

13

14

1 Direction arrows 10 Event screen
2 Floor designation 11 Event-based texts
3 Lift-specific logo 12 Dialog box selection list
4 Floor texts 13 Opened dialog box
5 - 8 Lift-specific information text 14 Auto-animate area
9 Slide-Show 

Tool tip! 
If you move the mouse cursor over one of the large squares in the position frame, the meaning of the 
respective position frame is displayed.

Adjusting the zoom factor 

	►Activate the desired zoom factor to adjust the size of the design preview.

Simulating the display preview of a floor drive 

	►Click on the Auto Animate button.

Opening/closing dialog boxes

Opening dialog boxes 

	►Click on the arrow button 

Closing dialog boxes

	►Click on the arrow button 
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4.2.1	 Layout dialog box

	►Click on the arrow button  next to Layout.

The Layout dialog box opens. 

Displaying/hiding position frames

Displaying position frames

	►Activate the Show Layout Help checkbox in the dialog box.

Hiding position frames

	►Deactivate the Show Layout Help checkbox in the dialog box.

Moving position frames

	►Activate the appropriate Border checkbox in the dialog box.

	►Use the mouse to grab a position frame on the large square and freely move the frame.

Enlarging/reducing position frames

	►Activate the Show Layout Help checkbox in the dialog box.

	►Use the mouse to grab one of the small squares and freely enlarge or reduce the size of the frame. 
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Displaying/hiding coordinates

Displaying coordinates

Displayed coordinates are an additional positioning aid. The coordinates are only displayed if the Display 
Layout Help checkbox is also activated.

	►Activate the Show Layout Help checkbox in the dialog box.

	►Activate the Show Coordinates checkbox in the dialog box. 

Hiding coordinates

	►Deactivate the Show Coordinates checkbox in the dialog box.
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Selecting the orientation

When starting a new project, you are prompted to select the model of your position indicator and its 
orientation in the New Project window.

The preselection is displayed in the Layout dialog box and can be changed or corrected here.

	►Select the model of your position indicator.

	►Select Horizontal if the display is positioned in landscape format.Select Vertical if the display is 
positioned in portrait format.

Example: vertical display

Displaying the Floor Text option

Floor Text is only displayed in the selection list of the dialog box if you activated it in the Layout dialog 
box.

	►Activate the Floor Text checkbox if you would like to work with floor texts.

An editable position frame is added in the preview. Floor Text is now displayed in the selection list of the 
dialog box. 
See “Floor Texts dialog box” on page 17.
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Displaying the Event-Based Texts option

Event-Based Texts  is only displayed in the selection list of the dialog box if you activated it in the Layout 
dialog box.

	►Activate the Event-Based Texts checkbox if you would like to work with event-based texts.

An editable position frame is added in the preview. Event-Based Texts is now displayed in the selection 
list of the dialog box. 
See “Event-Based Texts dialog box” on page 21.

Displaying the Slide-Show option

Slide-Show is only displayed in the selection list of the dialog box if you activated it in the Layout dialog 
box.

	►Activate the Slide-Show checkbox if you would like to work with multiple image files or with image 
and text files that are displayed alternately on the display.

An editable position frame is added in the preview. Slide-Show is now displayed in the selection list of 
the dialog box. 
See „Slide-Show dialog box“ on page 28.
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4.2.2	 Floor Designation dialog box

The floor designations are adopted from the FST by default. Numerous options are available for 
visually adjusting the designations.

	►Click on the  arrow button next to Floor Designation. 
The Floor Designation dialog box opens. 

Selecting a floor designation

	►Select a floor designation that is representative for your design.

	►Enter this floor designation in the two input fields in the Designation area.

The selected designation is only used for the preview. Every setting that you define or change in this dialog 
affects all floor designations.

Formatting characters

Aligning characters horizontally

	► In the Alignment drop-down menu, select Left, Right or Center to align the floor designation horizon-
tally within the position frame.

Aligning characters vertically

The position of the floor designation within the position frame is dependent on the selected alignment 
and margins. The set spacings remain fixed, even if the position frame is moved, enlarged or reduced.

	► In the Margins area, enter numerical values in the Left, Top and Right input fields or use the arrow 
buttons to define the fine adjustment for the position of the floor designation.

Setting a fixed digit width

Depending on the font, digits may have different spacing, which may cause numbers to appear 
unsteady when the display changes from single digits to double digits. Set a fixed width for all digits to 
avoid this.

	►Activate the Fixed digit width checkbox.
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Setting the character spacing

	►Move the Stretch slide control to the left (value < 1) to decrease the character spacing.

	►Move the Stretch slide control to the right (value > 1) to increase the character spacing.

Setting the font and font size

	►Activate the Basic XP fonts onlycheckbox to restrict the selection to basic Windows XP fonts.

	►Select the desired font from the drop-down menu. 

	►Select a font style from the drop-down menu.

	►Use the slide control to set the font size.

Testing characters

	►Perform a character test to check your design for compatibility:

	• Click the  arrow button next to Test Characters. 
Another dialog window opens.

	• Move the slide controls to display the various character combinations in your design.

Floor Designation - Colors dialog box

You can also customize the characters in your display with effects such as stroke or gradients.

	►Click on the  arrow button next to Colors.

The Floor Designation dialog box is expanded to include the Colors area. 

Adding/removing stroke

Adding stroke

The preset value for Width is 0, i.e., no text stroke.

	►Move the Width slide control to the right to add text stroke.

As soon as the width has a value of at least 1, the program uses the following:

	• Effect: None, for a one-color stroke

	• Color1: Black

	• Edge-Option: Round

	►Select a color for the stroke in the Color1 drop-down menu.

	►Select the type of stroke in the Edge-Options drop-down menu. 

	• Miter - sharp corners

	• Bevel - bevelled corners

	• Round - round corners

Miter  Bevel  Round  
 

Removing stroke

	►Set the Width slide control to 0.
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Adding/removing gradients for text and stroke

Adding a gradient

	► In the Effect drop-down menu, select a gradient direction. 

The program enables the Color2 option.

	► In the Color2 drop-down menu, select the color into which Color1 is to fade (gradient).

Removing gradients

	► In the Effect drop-down menu, select the None option.

Floor Texts dialog box

In addition to the floor designations (B, GF, 1, 2, ...), individual floor texts can be added to the design.

You can only select the “Floor Text” dialog box if you previously activated the “Floor Text” checkbox in the 
“Layout”dialog box.

	►Click on the arrow button  next to Layout. 
The Layout dialog box opens. 

	►Check whether the Floor Text checkbox is active; activate it if necessary. 
The Layout dialog box can be closed again.

	►Click on the arrow button  next to Floor Text. 
The Floor Text dialog box opens. 
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Adding/changing floor texts

	►Click on the line of text of the floor for which you would like to change the position indicator.

	►Double-click on the respective line of text in the Floor Text column.  

The text can now be edited.

	►Adjust the font, style and color of your floor texts. 

Each change is displayed in the preview. 

See “Setting the font and font size” on page 16; 
See “Floor Designation - Colors dialog box” on page 16.

Display floor texts during the drive

By default, the floor texts are only displayed while stopped on the floor. If you would like floor texts to 
be displayed during travel:

	►Activate the Show the floor text when driving checkbox

Using your own floor designations (forced floor designation)

By default, floor designations are limited by the FST to two characters. For some applications, two 
characters are not enough, however. If your floor designations contain special characters or if more 
than two characters are needed, you can create your own floor designations.

Forced floor designations can contain up to five characters.

	►Activate the Use forced floor designation instead of/in addition to FST text checkbox.

	►Double-click on the respective line of text in the Forced floor designation column.  

The text can now be edited.

	►Enter your floor designation. A double asterisk indicates the floor designation preset by the FST.

	►Adjust the font, style and color of your floor texts. 

Each change is displayed in the preview. 

See “Setting the font and font size” on page 16; 
See “Floor Designation - Colors dialog box” on page 16.

Examples

Input Preview of the floor designation

**.FL 01.FL

1/2 1/2 (FST designation is ignored)

F** F01

Deleting floor texts

	►Deactivate the Show the floor text when driving checkbox.

	►Deactivate the Use forced floor designation instead of/in addition to FST text checkbox.
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4.2.3	 Arrow Type dialog box

In this menu, you can individually design each display arrow independent of one another.

	►Click on the arrow button  next to Arrow Type. 
The Arrow Type dialog box opens. 

	► In the Selected Arrow area, select the display arrow that you would like to visually modify.

	►Activate the Shadow checkbox if you would like to add a shadow effect to the arrow.  
For information on individually designing the shadow effect:  
See “Shadow Effect dialog box” on page 24.

	►Activate the Bevel checkbox if you would like to add a bevel effect to the arrow.  
For information on individually designing the bevel effect:  
See “Bevel Effect dialog box” on page 25.

Activation of the “Shadow” and “Bevel” checkboxes acts on the floor designation as well. The settings for 
shadow and bevel effect are automatically taken over by the program for the floor designation.

Adding/removing animation

Adding animation

	► In the Animation  drop-down menu, select an animation type. 

The program does not offer a preview for this feature.

Removing animation

	► In the Animation  drop-down menu, select the Non Animation option.

Creating custom arrows

For special needs, you can also design your own arrows.

	► In the Arrow Type dialog box, select the Custom Arrow option.

	► In the input field, enter the program code for the user-defined arrow type.  
See „Expert knowledge“ on page 30.
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4.2.4	 Arrow Type - Colors dialog box

You can also customize the arrows in your display with effects such as stroke or gradients.

	►Click on the  arrow button next to Colors.
The Arrow Type dialog box is expanded to include the Colors area. 

Adding/removing stroke

Adding stroke

	►Use the Width slide control to adjust the weight of the arrow stroke.

	►Select the type of stroke in the Edge-Options drop-down menu. 

	• Miter - sharp corners

	• Bevel - bevelled corners

	• Round - round corners

Miter  Bevel  Round  
 

Removing stroke

	►Set the Width slide control to 0.

Adjusting gradients for arrows and stroke

Adding a gradient

	► In the Effect drop-down menu, select a gradient direction. 

The program enables the Color2 option.

	► In the Color2 drop-down menu, select the color into which Color1 is to fade (gradient).

Removing gradients

	► In the Effect drop-down menu, select the None option.
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4.2.5	 Event-Based Texts dialog box

The EAZDesigner makes available a list with preset event-based texts (e.g., “Maintenance” or “Out-
of-order”). All event-based texts can be edited and expanded. If no event is active, the date with time 
(output by the FST) can be displayed instead of the event-based text if desired.

Additional informational text can be displayed with each event-based text. Event-based text and 
information text are displayed alternately. The information text can be used for translations, e.g., to 
alternately display German and English.

You can only select the “Event-Based Texts” dialog box if you previously activated the “Event-Based Texts” 
checkbox in the “Layout””dialog box.

	►Click on the arrow button  next to Layout. 
The Layout dialog box opens. 

	►Check whether the Event-Based Texts checkbox is active; activate it if necessary.  
The Layout dialog box can be closed again.

	►Click on the arrow button  next to Event-Based Texts. 
The Event-Based Texts dialog box opens. 

You have the possibility to supplement event-based texts (Text1 and Text2) with information (Info1 and 
Info2) or to edit the event-based texts themselves. The texts are preset to German/English. 

Adding/deleting event and information text lines

Adding a line

	► In the Id area, click on the  button to add a new event line. 

Deleting a line

	► In the Id area, click on the  button to delete an event line. 
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Changing event and information texts

	►Click on the table row of the event that you would like to change (in the example: row 6).

	►Double-click on the corresponding table cell of column Text1;Info1 or Text2;Info2 (in the example: 

Text1,Info1). 

The text can now be edited. The Text and Symbol areas are now automatically activated.

	►Activate the Inside and Outside checkboxes depending on where the text is to appear during floor 

drives.  

	►Change the text as you desire (e.g., to “Attention! Fire!”).

	►Add an information text if necessary:
	»Place a semicolon [;] after the event-based text.

	»Then enter the desired information that is to be displayed (e.g., “Exit building!”). 

The text must be entered in the following sequence: event-based text - semicolon - information text 
(e.g., “Fire alarm!;Exit Building!”).

	►Move the slide control next to “Preview Sub-text” to Text1, Info1, Text2 or Info2 (in the example: 

Text1) to display your entry in the preview.

	►Adjust the font, style and color of your event-based texts. 

Each change is displayed in the preview. 

See “Setting the font and font size” on page 16; 
See “Floor Designation - Colors dialog box” on page 16.

	►Activate the “Blinking Text” checkbox if you would like to alternately display event-based text and 
information.

You cannot format event-based text and information text independent of one another.
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Adding/changing symbols

You have the possibility to supplement the event-based texts with suitable symbols. Symbols are 
embedded as graphics in PNG format. The graphics can be displayed as an icon next to the text or as a 
full image above.

	►Click on the table row of the event for which you would like to add or change a symbol.

	►Activate the “Use symbol” checkbox and select a graphic using the  button. 

	►With the Full image checkbox, determine whether the symbol is to be placed as a small icon next to 

the event-based text or as a full image above the event-based text.

	►Activate the Shadow checkbox if you would like to add a shadow effect for the symbol.

	►Use the Size slide control to change the size of the symbol.

Displaying/removing the date and time

Displaying the date and time 

	►Click on the table row with Id 0 - Normal.
	►Activate the Inside and Outside checkboxes depending on where the date and time are to appear 

during floor drives.  

Removing the display of date and time

	►Click on the table row with Id 0 - Normal.
	►Activate the Inside and Outside checkboxes depending on where the date and time are not to 

appear during floor drives.  

Setting the date and time format

	►Click on the table row with Id 0 - Normal.
	►Click on the  arrow button next to “Date/Time...”. 
The Date/Time dialog box opens.

	► In the drop-down menu under Format, set the desired date format. 

	►Use the arrow buttons next to Position to change the number values in the numerical fields for 

positioning the date and time. You can also enter the number values by hand. 

If you change the format of the month names, be sure to adjust the font size – if necessary due to space 
reasons – so that the entire text can be displayed.
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Checking settings

You have two possibilities for checking your settings.

	►Click on the respective event in the table. The preview appears at the left in the display window. 

Or

	► In the Demo window, click on the Auto-Animate button in the Events area. 

The various events are cycled through and displayed in sequence. Use the slide control Preview Sub-text 
to set which of the event columns (Text1, Info1, Text2 or Info2) is displayed in the display window.

4.2.6	 Shadow Effect dialog box

Shadows give your position indicators and arrows a three-dimensional appearance.

You can only set the shadow effect if you previously activated the “Shadow” checkbox in the “Arrow Type” 
dialog box.

	►Click on the arrow button  next to Arrow Type 
. The Arrow Type dialog box opens. 
	►Check whether the Shadow checkbox is active; activate it if necessary.  
The Arrow Type dialog box can be closed again.

	►Click on the arrow button  next to Shadow Effect 
. The Shadow Effect dialog box opens. 
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Adding/removing shadow effect

Adding shadow effect

	►Use the Shadow Depth slide control to adjust the intensity of the shadow.

	►Use the Softness slide control to set how sharp or soft the shadow should be drawn.

	►Use the Angle slide control to set the direction in which the shadow should fall.

	►Select a shadow color in the Color drop-down menu.

	►Use the Noise slide control to set a shadow noise level.

Removing shadows

	► In the Shadow Effect dialog box, set the shadow width to 0 or

	►open the Arrow Type dialog box and deactivate the Shadow checkbox.

Restoring shadow defaults

	►Click on the Set Shadow Defaults button. 
The default values defined by the program are restored.

4.2.7	 Bevel Effect dialog box

With the bevel effect, you can give floor designations and arrows a plastic effect.

You can only set the bevel effect if you previously activated the “Bevel” checkbox in the “Arrow Type” dialog 
box.

	►Click on the arrow button  next to Arrow Type 
. The Arrow Type dialog box opens. 
	►Check whether the Bevel checkbox is active; activate it if necessary.  
The Arrow Type dialog box can be closed again.

	►Click on the arrow button  next to Bevel Effect 
. The Bevel Effect dialog box opens. 
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Adding/removing bevel effect

Adding bevel effect

	►Use the Width slide control to adjust the thickness of the bevel.

	►Select an effect from the Effect drop-down menu.

	• Linear 

	• CurvedIn

	• CurvedOut 

	• BugeldUp

Linear CurvedIn CurvedOut BulgedUp 

Removing bevel effect

	► In the Bevel Effect dialog box, set the Width to 0. 

or

	►Open the Arrow Type dialog box and deactivate the Bevel checkbox.

4.2.8	 Lift-Specific Info Texts dialog box

Here, you can add a logo to your design or place information that is to appear permanently in the 
display (independent of window). 

	►Click on the  arrow button next to Lift-Specific Info Texts. 

The Lift-Specific Info Texts dialog box opens.
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Inserting a position frame for text

	►Click on the Add Text-Box button. 
The position frame is displayed in the preview.

	►Click in the position frame to edit the text.

	►Enter the desired text.

	►Use the drop-down menus in the Font area to select the desired font, style, color and font size.

Inserting a position frame for a logo

	►Click on the Add Logo button. 
The program opens an Open File dialog box.

	►Navigate to the desired graphic and confirm with the Open button. 
The selected graphic is inserted into its own position frame.

Moving position frames

See “Moving position frames” on page 11

Enlarging/reducing position frames

See “Enlarging/reducing position frames”on page 11

Deleting position frames

	►Right-click in the position frame. 
A selection window opens.

	►Select the Clear Text Box/Clear Logo option.

	►Confirm the query Do you really want to delete the text box? / Do you really want to delete the logo? with 
Yes.

Only position frames that were added in the “Lift-Specific Info Texts” area can be deleted again. 
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4.2.9	 Slide-Show dialog box

Here, you can position information or images that are to appear in sequence on the display. 

You can only make settings in the “Slide-Show” dialog box if you previously activated the “Slide-Show” 
checkbox in the “Layout” dialog box.

	►Click on the arrow button  next to Layout. 
The Layout dialog box opens. 

	►Check whether the Slide-Show checkbox is active; activate it if necessary.  
The Layout dialog box can be closed again.

	►Click on the arrow button  next to Slide-Show. 
The Slide-Show dialog box opens. 

Adding/removing slides

Add a slide

	►Click on the   button. 
Level Slide 1 is inserted in the Slide area.

As in the Lift-Specific Info Texts area, both position frames for text boxes as well as position frames for 
logos can be added to this level.

See “Inserting a position frame for text” on page 27 
See “Inserting a position frame for a logo” on page 27 
See “Moving position frames” on page 11 
See “Enlarging/reducing position frames” on page 11

Deleting a slide

	► In the Slides area, select the slide that is to be deleted.

	►Click on the  button.

	►Confirm the Delete slide? query with Yes. 
The selected slide, including all position frames, is deleted. 
The deleted slide is no longer displayed in the Slide area.
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4.3	 Background tab

In the Background tab, you can color the background of your design or load your own graphic.

Loading/deleting your own background (graphic)

Loading a background

	►Click on the Load Image button. 

	►Select the desired graphic by means of a mouse click.

	►Click on “Open”. 
The graphic is loaded in the background. 

If the graphic you selected includes the “Opacity” function, this can be combined with the background 
settings. The colors are displayed in the transparent areas of the graphic.

Deleting the background

	►Click on the No Image button. 

Adding a gradient

	► If necessary, open the Color dialog box. 

Click on the arrow button next to Gradient Properties.

	►Use the Color Top, Color Middle and Color Bottom drop-down menus to select the desired color for the 

upper part of the position indicator.

	►Adjust the Position Middle slide control to change the alignment of the middle.

Adjusting opacity

	►Use the Color Behind Opacity drop-down menu to select the color that is to be behind the color 

gradient.

	►Use the Opacity slide control to specify how strongly the selected background color is to appear 

through the gradient. The further you move the slide control to the left, the stronger the color 

behind the opacity appears.
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4.4	 Expert knowledge

Programming arrows yourself

You can create your own arrows with simple programming commands.

Description Command

Start new polygon:
	»M 	— start of new polygon
	»x 	 — x-coordinate
	»y 	 — y-coordinate

M x,y

End polygon(s):
	»Z 	 — end polygon

Z

Insert free line:
	»L 	 — line from current point to x,y:

L x,y

Insert horizontal line: 
(y remains constant)

	»H 	— horizontal line from current point to x

H x

Insert vertical line: 
(x remains constant)

	»V 	— vertical line from current point to y

V y

Insert Bézier curve:
	»C 	— Bézier curve from current point to x,y via x1,y1 and x2,y2

C x1,y1 x2,y2 x,y

Insert quadratic Bézier curve:
	»Q 	— quadratic Bézier curve from current point to x,y via x1,y1

Q x1,y1 x,y

Insert continuing smooth Bézier curve:
	»S 	 — continuing smooth Bézier curve from current point to x,y via 
x2,y2 and based on x2,y2 of previous Bézier curve

S x2,y2 x,y

Insert ellipse:
	»A 		 — ellipse from current point to x,y
	» rx,ry	 — radius in X-direction and Y-direction
	»deg 	— inclination of the ellipse
	» isLargeArch
	»dir 	 — direction (0 anticlockwise,1 clockwise)

A rx,ry deg isLargeArch 
dir x,y

Overlapping areas:
	»Fvalue — specifies how the overlapping areas of the polygons are 
combined. The default value is EvenOdd.

EvenOdd

	»EvenOdd (q) — determines whether a point is located within the 
shape by drawing an infinite beam from this point in an arbitrary 
direction and counting the number of intersected path segments in 
the specified shape. 
	» (odd number) — the point is located in the fill area
	» (even number) — the point is located outside of the fill area

EvenOdd (0)

	»NonZero (q) — determines whether a point is located within the 
shape by drawing an infinite beam from this point in an arbitrary 
direction and then checking the locations at which the beam inter-
sects a segment of the shape.  
Start with the value 0 (zero) and add the value 1 for each point at 
which the beam intersects a segment from left to right. Subtract the 
value 1 for each point at which a path segment intersects the beam 
from right to left.  
If, after counting the intersections, the result is 0 (zero), the point is 
located outside of the path. It is otherwise located within the path.

NonZero (1) 
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Programming example

Double polygon Command

M 0,100 10,100 36,15 62,100 72,100 41,0 31,0 Z 
M 0,165 10,165 36,80 62,165 72,165 41,65 31,65

Making the files of ProgramData Windows directory visible

Windows does not display the C:\ProgamData directory by default. You may need to use the settings in 
Windows Explorer to make the directory visible.

	►Start Windows Explorer

	► In the Organize menu, select the Folder and search options option.

	►Select the View tab in the Folder Options window

	►Activate the Show hidden files, folders and drives function

	►Confirm with OK.
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4.5	 Final steps

Saving your own design for use with the TFT

After you have created the desired design, save it in order to be able to use it. 

	►Select the Display tab; your design opens.

	►Click on Create Display Output in the menu bar. 

A browser window opens.

	►Navigate to the the memory location at which you would like to store your design. 

	►Confirm with OK.  

Your design appears in the display area.

	►Confirm the displayed Output message with OK. 

The design was stored as folder eaz in the location selected by you.

Loading your own design on the TFT

	►Provide the memory medium (USB stick or memory card) suitable for your TFT version. 

See chapter “2.1.1 Hardware” on page 6
	►Connect a FAT-formatted USB stick / an SD card to your computer.

	►On the USB stick / SD card, create a folder named designs.

	►Drag the eaz folder to the designs folder you just created.  

Wait until your computer has written all of the data to the USB stick / SD card.

	►Properly remove the USB stick / SD card from your computer.

The further procedure is dependent on your TFT version.  
See the EAZ-TFT manual.

4.6	 Tips for creating position indicators

	►First create a background (e.g., an image file with your company logo) and then position the display 
elements. You thereby ensure that the display elements are in harmony with the background.

	►Open the Layout dialog box and leave this open during the entire design process. In this way you can 
check the position of the individual elements at any time.

	► In the Layout dialog box, select whether you would like to display extended floor texts.  
Specify whether you will use a single-colored background or a photo or image file.

	► If you would like to display extended floor texts, you must move or enlarge position frames if 
necessary before these settings become visible.
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